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Introduction

Congratulations and thank you for buying the Sony Ericsson GPRS PC Card Modem GC75. The 

GC75 is a triple band GSM product that enables you to communicate wirelessly from your laptop on 

all five continents, in over one hundred and sixty countries. As the GC75 provides wireless 

communications you no longer need to carry cables, telephone jack converters, chargers and 

batteries. The GC75 is very simple to install and use; the software provided allows you to select the 

best data service available so that the GC75 is always available for data transfer.

The GC75 enables your laptop PC to:

• Browse the Internet

• Send and receive e-mails

• Receive information services in real time

• Access files, databases and discussion groups

• Send and receive SMS text messages

• Edit SIM card entries

Note:
Before using your GC75 you MUST read Important Information on page 41.

Hardware Overview

The GC75 is a standard 16 bit type II PC card. It is standard length and only the antenna protrudes 

outside the PC card slot. 

The GC75 operates in 3 or 5 volt slots by automatically switching to the correct voltage. The amount 

of power drawn from the laptop battery is dependant upon a number of factors including status, 

frequency band, distance to GSM base station and number of timeslots used. See Technical 

Specifications on page 43 for a general guide to power consumption.

Before you can start using the GC75 you need to put the hardware together. You will also need a 

SIM card.

SIM Card

When you subscribe to a mobile network operator, you are issued with a SIM card (Subscriber 

Identity Module card). The SIM contains your personal subscriber data. You need a SIM to use 

GC75.



6 Introduction

Software Overview

GC75 Manager

You can use the GC75 Manager to:

• Display GC75 status information

• Create or modify connection settings

• Connect to the Internet or a corporate network

• Manage GC75 settings

• Manage SIM card and PC phonebooks

• Send and receive SMS messages

Using the GC75 with your Applications

Data Programs

You can use the GC75 as a modem to provide Intranet/Internet connectivity for a wide range of 

applications. 

The GC75 can also be programmed at command level by application developers for more details see 

the AT Commands Manual.

Fax Programs

You can use the GC75 as a fax provided you have the correct software, e.g. Microsoft Fax (Windows 

2000 and XP).

The GC75 can also be programmed at command level by application developers for more details see 

the AT Commands Manual.

Documentation

The GC75’s documentation is designed to enhance your understanding of its capabilities. The 

following guides are provided:

• A printed Quick Start Guide aimed at getting you operational as quickly as possible.

• An online User’s Guide (this document) containing a comprehensive description of the GC75 

functionality. You can read the guide on the computer screen or print it on to either European A4 

or American Letter sized paper.

• An online AT Commands Manual, aimed at application developers, containing a full list of all 

the modem commands that can be used with GC75. The manual can be read online or printed in 

the same way as the User’s Guide.

The User’s Guide and the AT Commands Manual are located on GC75 CD-ROM as Adobe Acrobat 

PDF files. The GC75 CD-ROM also contains Adobe Acrobat Reader® which you can install if 

necessary.

The User’s Guide and the AT Commands Manual can be saved on to your computer’s hard drive 

during the software installation. If you selected the shortcut option during installation the 

documentation is accessed via Start  Programs  Sony Ericsson. Alternatively you can open 

the documentation and either read or print it directly from the CD-ROM. 
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Illustrations

The illustrations in this manual were obtained using the GC75 on a Microsoft Windows® 2000 

operating system. The dialogs that appear on your PC may differ depending on the version of 

Windows® in use.
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Getting Started

Checklist

Make sure the following items are in the box when you unpack it:

• Protective plastic case for storing the GC75 and its antenna

• GC75 PC Card

• SIM tray

• Antenna

• Quick Start Guide

• CD-ROM 
The CD contains; drivers, software, documentation and a readme file.

System Requirements

This section lists the network subscriptions, hardware and software requirements for running the 

GC75 PC Card.

Network and Subscription

The network subscription you use in conjunction with your GC75 depends on the subscriptions your 

network operator can provide. Contact your network operator or service provider to make sure the 

options you require are available. Make sure that data options are included in your subscription, as 

these are usually optional services.

Note:
Mobile operators often provide a number of connectivity options via GPRS such as WAP and 

Internet, so check that the Internet or VPN service you require is enabled for your subscription.

The functionality of the different subscriptions available from networks operators are discussed 

below:

Circuit Switched Data (CSD)

CSD is the original GSM network data transfer method, used in the past for WAP. Almost all GSM 

networks have this capability at 9.6 kbps. It is possible for the network to upgrade the speed to 

14.4 kbps. The GC75 operates at this higher speed where available.

High Speed Circuit Switched Data (HSCSD)

HSCSD is an enchanced GSM network capability offered by some network operators. It enables 

circuit switched data connections to run at a higher data speed, using more than one wireless 

‘timeslot’ for the data transmission. This is ideal for providing a faster connection to existing 

corporate or ISP dial-up facilities. The preferred connection speed is selected when you define the 

connection using the Connection Wizard.
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General Packet Radio Service (GPRS)

GPRS is a new network connection which provides “always on” mobility. The connection set up is 

fast and, once connected, applications may send and receive data whenever required. In today’s 

GPRS networks, the GC75 receives data at speeds up to 53.6 kbps and transmits at speeds up to 26.8 

kbps. 

Short Message Service (SMS)

The PC can send and receive SMS text messages using the SMS Messages screen in the GC75 

Manager, see GC75 Manager SMS Messages Screen on page 33, for more details. 

Hardware

You will need:

• A PC that has the minimum specification recommended by Microsoft to run the version of 

Windows® installed on it.

• A 16 bit type II PC Card slot.

• Sony Ericsson GPRS PC Card Modem GC75

Software

You will need:

• Windows® 98SE, Me, 2000 (SP2) or XP.

• Sony Ericsson GC75 Communication Suite CD-ROM.

Services Available Over the Internet

The Sony Ericsson web site contains support to facilitate easy communications and rapid 

information retrieval, wherever you are. It gives you access to on-line customer services, on-line user 

manuals, software downloads, and useful information. The address is:

http://www.SonyEricsson.com/support

Sony Ericssons home page address is:

http://www.SonyEricsson.com
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Installation

The GC75 Communication Suite CD-ROM contains the software required to operate your GC75. 

The software is simple to set up and operate, but before you begin you will need to make sure that 

the services you require are included on your SIM card subscription. For an explanation of the 

services that are available see Network and Subscription on page 8. Contact the organisation that 

supplied you with your SIM card and request that the specific services (GPRS, HSCSD, CSD or 

SMS) you require are added to your subscription.

The CD-ROM contains the following software:

• GC75 Manager

• User Documentation

• On-line Help

• ReadMe text file containing the latest information about the GC75

GC75 Hardware Set Up

1. Collect your GC75 card, antenna and SIM card together.

2. Place the SIM card in to the GC75 SIM tray and push the tray back into the GC75. Make sure the 

tray is closed properly before proceeding.

Note:
The cut corner of the SIM card must be placed into the SIM tray as demonstrated below, the 

SIM contacts should face upwards.

3. Connect the antenna to the GC75.

Installing the Software

1. Insert the GC75 Communication Suite CD-ROM in your CD drive.

GPRS PC Card Modem

GC75
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After a few seconds a Sony Ericsson splash screen is displayed.

Note:
If the CD-ROM does not autorun, select Start  Run and type D:\Setup.exe into the Run 

dialog. (Where D is your CD drive.)

2. The Choose Setup Language dialog opens. Click on the drop down list and select the 

installation language for your GC75 Software. Click OK.

3. The InstallShield Wizard for Sony Ericsson GC75 Manager opens; follow the instructions on 

screen. When installation is complete click Finish.

4. Insert the GC75 PC Card. Make sure the GC75 is fully inserted. A beep signals that your 

computer has recognised it. 

5. Your PC recognises that new hardware has been inserted and installs the necessary driver. This 

process will take a few seconds.

6. Select Programs  Sony Ericsson  GC75 Manager to start using your GC75.

7. The GC75 and GC75 Manager are ready for use. 

GPRS PC Card Modem

GC7
5
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Start Using GC75 Manager

1. To start GC75 Manager select Start  Programs  Sony Ericsson  GC75 Manager.

2. If requested, enter your SIM Card/Phone Lock PIN and click OK. It is only necessary to enter 

the PIN number once during a PC session.

You are allowed three attempts to enter the correct PIN code. If you fail to enter the SIM PIN 

correctly it is blocked and if you fail to enter the Phone Lock PIN correctly your GC75 is 

locked. Contact your network operator for an unblock code (PUK). Enter the unblock code into 

the Card Blocked dialog and enter a new PIN code and confirm it. 

To set the SIM Card PIN and Phone Lock PIN, see Locks on page 23.

3. The Radio dialog opens, select the required state for your GC75 radio transmission. See GC75 

Manager Settings Options on page 14 for more details.

4. The GC75 Manager opens, displaying the Status screen. Connectivity details are displayed on 

this screen, the current signal strength and GPRS availability should be listed. See GC75 

Manager Status Screen on page 20, for more details.

5. The GC75 Manager Icon is displayed in the system tray of your PC.

GC75 Manager Icon

The GC75 Manager Icon shows the current status of the GC75, which is typically the current 

network signal strength and the GSM/GPRS service status, similar to a mobile phone display. If you 

right click on the GC75 Manager Icon a menu is displayed, see The GC75 Manager Icon Menu on 

page 13 for details on the menu options.

Place your mouse cursor over the GC75 Manager Icon to display text indicating:

• GSM or GPRS Service availability

• Network name

• Connection information

Two standard Windows® operating system icons also appear in the system tray when the GC75 is 

inserted in your PC. They are the Dial-Up Networking icon and the PC card icon.

• Dial-Up Networking Icon (DUN) 
This icon is only visible when a dial-up connection has been established. This icon gives you 

information about the active GC75 connection. Right click on the icon to see the Dial-Up 

Networking menu; you can also disconnect a connection from here. See Start  Help for more 

details. 

• PC Card icon 
Indicates that a PC card is present and allows the user to see certain properties and also to stop/

remove the card. 

Dial-Up Networking icon

GPRS Manager IconPC Card icon
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Safe Removal of the GC75

You must stop the GC75 before attempting to remove it. 

1. Close the Dial-up Networking Connection.

2. Exit GC75 Manager.

3. Click on the PC Card icon. A list of currently connected PC Cards is displayed. Select Stop 

Sony Ericsson GC75 Wireless Card. 

4. A dialog is displayed telling you it is safe to remove the card.

Important!
Incorrect removal of the GC75 can damage the card.

GC75 Manager Icon Status

The GC75 Manager Icon icon displays the status of the GC75 network connection. 

The GC75 Manager Icon Menu

Right click the GC75 Manager Icon icon to see the menu options. When you right click on the icon 

the GC75 Manager is displayed.

Note:
Some of the GC75 Manager Icon icon menu options are disabled, depending on the current 

state of the GC75.

The GC75 Manager Icon menu options are described below.

Open

Select Open to open the GC75 Manager. For more information on a current HSCSD or GPRS 

connection use your mouse and hover over the GC75 Manager Icon and the standard Windows 

Dial-Up Networking Icon (DUN) or look at the Status screen of the GC75 Manager.

Radio Status 

This menu option is dynamic. It monitors the current state of the GC75 radio transmitter and gives 

you the option to switch to the opposite state, for example, if your GC75 Radio transmitter is on the 

menu option reads Turn Radio Off. 

Radio is set to off or the GC75 Manager has disconnected the GC75

The radio transmitter is enabled, but there is no GSM or GPRS service 
available

The GC75 has GSM service and indicates a signal strength of 3 out of 5 
bars. CSD, HSCSD, SMS and fax may be used, provided these are 
supported by the subscription. GPRS is not available

The GC75 has GSM and GPRS service
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You can also set the status of the radio transmitter by selecting Settings... in the GC75 Manager 

File menu. See GC75 Manager Settings Options on page 14, for more details.

Connect

Connects to the most recently used GC75 dial-up connection.

Help 

Opens the GC75 Manager Online Help. You can also launch the Online Help from the GC75 

Manager Help Menu. Pressing F1 in any of the GC75 Manager dialogs opens the relevant help 

screen.

Exit

Closes the GC75 Manager, the GC75 Manager Icon remains in the Status Bar. Re-open GC75 

Manager to make full use of all the GC75 functionality.

GC75 Manager Settings Options

You can change the general behaviour of the GC75 Manager operates from the Settings... option in 

the File menu.

1. Select Settings... in the File menu. The Settings dialog opens, the Radio Power tab is 

displayed.

2. Use the tab to specify the start up, stand by and shutdown states you want the radio transmitter 

to enter. The radio mode you specify at GC75 Manager start-up will appear selected on the 

Radio tab.

On Switches the modem’s radio transmitter on.

Off Switches the modem’s radio transmitter off.

Ask Triggers a dialog to be displayed every time the PC is 
turned on. The dialog asks you if the radio transmitter 
should be turned on or off during the active PC session. 
This is also called Aeroplane mode, because it prevents 
the radio transmitter automatically turning on. This is a 
useful feature in areas where radio transmitters are not 
allow; aircrafts, hospitals or blasting areas.
Your GC75 is set to Ask by default.
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3. Click the Text Messages tab. Use this tab to enable reception of specific message classes from 

the SMS Cell Broadcast service and to set the SMS received audio alarm to on or off. Select the 

radio buttons to activate the options.

Example of SMS Cell Broadcast message types:

To enter multiple SMS Cell Broadcast message types separate each entry with a comma, for 

example, 000, 034, 076.

Note:
SMS Cell Broadcast message types are network operator specific. Contact your network 

operator for more details.

4. Click the Notifications tab. You can decide if you want to display a splash screen every time 

GC75 Manager is opened and a program end confirmation box. Select the radio buttons to 

activate the options. 

5. Click the Miscellaneous tab.

6. From this tab you choose to: 
Hide To Tray When Minimized - if checked only GC75 Manager icon in the system tray is 

visible, when GC75 Manager is minimized. The GC75 Manager is not displayed in the 

Windows task bar. 
Show Menu Item for Modem Software Update - if checked Modem Software Update... 

appears in the File menu. Select Modem Software Update... to prepare your GC75 modem 

drivers for a firmware update, using the Sony Ericsson Update Service Tool. 

Leave Radio As Is At shutdown the card is left powered as is (could be on or 
off depending on previous user action) and any 
established connection is left alone.

Turn Radio Off At shutdown the radio is turned off.

Reset card Resets the GC75 default settings.

Code: Cell Broadcast Message

000 Index

010 News Flashes

020 Hospitals

030 Long-distance road reports

040 Weather

050 District (base station identity)
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Note:
To use the Modem Software Update... option, you must have the Sony Ericsson Update 

Service Tool. This is freely available on the Sony Ericsson’s web site, see 

www.SonyEricsson.com for more details. 

7. Click OK to save the changes and close the Settings dialog.
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Create a Dial-Up Connection

1. Click  in the menu bar or select View  Connection Wizard. The Connection Wizard 

opens.

2. Select the radio button next to Create a new dial-up connection, enter a name, for example 

‘My Connection’, click Next.

3. The Type of Connection screen opens. From here you select the type of connection you 

require:

• For GPRS see steps 4 to 8

• For CSD/HSCSD see steps 9 to 12

GPRS Connection

4. Select GPRS. Select your Network Operator from the Choose Network drop down list. If your 

Network Operator isn’t listed selected <Other>. Click Next.  
See Network and Subscription on page 8 for more information on GPRS.

Note:
Type the first letter of the Network Operator you require into the field to list all the operators 

that start with that letter.

Note:
The Choose Network list is created from a file supplied on the GC75 Communication Suite 

CD ROM. This file will be automatically updated by Sony Ericsson periodically.

5. Your Network Operator’s Access Point Name or Names (APNs) are displayed, click on the 

APN you want to use. If no APNs are listed contact your Network Operator and ask them to 

supply an APN. Click Add and enter the APN provided into the dialog.

6. To modify the selected APN’s settings, Click Advanced.... See Appendix A - Connection 

Parameters on page 53, for descriptions of the updateable parameters in the Advanced dialog. 

Click Apply to save any changes before closing the dialog. Click Next.

7. If you have a logon for your service provider, enter you User ID and Password into the specific 

fields. If you don’t need a username and password to connect leave the fields blank. Click Next.

Note:
Some versions of Windows® deliberately change the number of asterisks that represent a 

password and place asterisks in the password field when the password is blank in order to 

make the display secure.

8. Click Finish to create your Dial-up or Back to review your settings.
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HSCSD or CSD Connection

9. Select CSD/HSCSD. Select your Network Operator from the Choose Network drop down list. 

If your Network Operator isn’t listed selected <Other>. Click Next.

10. If you selected a Network Operator from the Choose Network drop down list, the telephone 

number screen should be automatically filled in.  
If you selected <Other> from the Choose Network drop down list; enter the number you need 

to dial to connect to your Network Operator in the Telephone Number field; include your 

country and area code. Ensure Use Area Code and Country Code is de-selected. Click Next.

Note:
Contact your Network Operator for a telephone number if necessary.

11. Click Advanced.... To create a CSD/HSCSD connection you must specify your preferred 

network connection speed from the drop down list and the method you want to use to connect to 

the network, on the Speed tab of the Advanced dialog. Click Next. 

Note:

If you are unsure which speed to choose from the Speed tab, start with 9600, and check to see 

if it works. If it is successful increase the speed until you find the appropriate setting.

See Appendix A - Connection Parameters on page 53, for descriptions of the updateable param-

eters in the Advanced dialog. Click Apply to save any changes before closing the dialog. 

12. If you need a User ID and Password to logon to your service provider enter them into the 

specific fields. If you don’t need a username and password leave the fields blank. Click Next.

Note:
Some versions of Windows® deliberately change the number of asterisks that represent a 

password and place asterisks in the password field when the password is blank in order to 

make the display secure.

13. Click Finish to create your Dial-up or Back to review your settings.
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Modify a Connection

1. Select Modify a Dial-up connection. The Select a Connection drop down menu is activated. 

Click on the menu and select the connection you want to modify.

2. Click Next. 

3. Change settings as required.

Delete a Connection

1. Select Delete a Dial-up connection. The Select a Connection drop down menu is activated. 

Click on the menu and select the connection you want to delete.

2. Click Next. The Success screen is displayed. Click Finish to close the Connection Wizard.

Using your Connection

To Connect

1. Open GC75 Manager.

2. If requested enter your SIM Card PIN and click OK. The Status screen is displayed.

3. Select the connection you require from the drop down list and click Connect.

To disconnect an active connection

1. Click Disconnect on the Status screen.

The GC75 Manager ends the connection.

Alternatively:

Right click on the Dial-up Networking icon in the system tray and select Disconnect.

Browse the Internet

You can connect to the Internet using a CSD/HSCSD or GPRS connection:

1. Open your preferred connection from the Status screen. See The Connection Monitor on page 

21 for details on opening a connection.

2. Start your Internet browser. You are online and can browse the Internet.

Send and Receive emails

You will need an email program installed on your PC in order to send and receive emails. You can 

send and receive emails using a CSD/HSCSD or GPRS connection:

1. Open your preferred connection from the Status screen. See The Connection Monitor on page 

21 for details on opening a connection.

2. Start your email program. You are online and can send and receive emails.
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GC75 Manager Status Screen

The Status Screen is displayed when GC75 Manager opens. You can also open the Status screen by 

clicking  or selecting View  Status.

The Status screen shows detailed SIM card and network status information. 

The left side of the screen shows graphical icons, representing:

• Receive signal strength

• GPRS service status

• Unread SMS Text Message  status (with SIM Full indication ). See GC75 Manager 

SMS Messages Screen on page 33 for more details.

• Connection status

The left side of the screen also displays:

• The current Network Status, e.g. searching, radio off

• The connection progress messages

The right side of the Status screen displays the Connection Manager. When a connection is 

established, the connection statistics (duration, bytes transmitted, bytes received) are displayed and 

updated at regular intervals.

Note:
Statistics display is not supported on Window 98(SE) or Me platforms. To view statistic data 

when using these operating systems hover your mouse cursor over the standard Windows 

Dial-up Networking icon.
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The Connection Monitor

The Connection Manager provides a means to connect, cancel or disconnect a GPRS or HSCSD/

CSD data session. A drop-down selection box displays all the connections you have defined. 

A drop-down menu allows you to quickly select the connection. 

The Control button, located underneath the drop down menu, changes it’s 

appearance depending on the state of the GC75 connection. The button 

allows you to:

• Initiate a dialup session (Connect)

• Cancel connection attempt (Cancel)

• Disconnect (Hang-up) an existing session

To create a Connection see Create a Dial-Up Connection on page 17.

Note:
You can also launch or terminate dialup networking sessions directly from the Windows 

Network Connections icon. 
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GC75 Manager Telephony Settings Screen

The Telephony Settings screen allows you view and change the GSM settings of the GC75.

The functions of the Telephony Settings screen are very similar to the settings that you have access 

to via a mobile phone’s display. 

Note:
Your GC75 has to be connected to your computer to make changes to the settings. 

1. Click  or select View  Telephony Settings.

The window is divided into two areas: the navigation area on the left and the information area on the 

right.

When you have selected a setting in the navigation area, GC75 Manager retrieves the current setting 

information from the GC75 and displays the information in the right area.

Phone Numbers

My numbers

You can list all your own numbers here. The numbers are for personal reference only and have no 

operational effect on the GC75.

Voice line 1 and 2:

The voice number or numbers issued with your SIM card that you use for normal voice calls. If you 

have line 2 (alternate line service) enter in the Voice Line 2 number field.
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Data:

The number used to make a data call to the GC75 (Mobile Terminated).

Fax:

The number used to send a fax to the GC75.

Click Apply when you have finished, to transfer the changes back to your GC75. This may take a 

few seconds.

SMS Service Centre

When you send a text message it goes to your operator's service centre, they then forward it to the 

correct recipient. The SMS service centre is identified by a telephone number.

Note:
The SMS Service Centre number is normally read automatically from your SIM card.

To Set or change the service centre address:

1. Enter your operator's service centre phone number in the Number text box.

2. Click Apply to transfer the setting to your GC75.

Locks

Phone lock

The phone lock protects the GC75 against unauthorized use if it is stolen and used with another SIM 

card. Phone Lock is not activated when you buy the GC75. 

You can use this screen to change the default security code (0000) to any four to eight digit 

personalized code.

You can set the Phone Lock Status to one of the following states:

• On - A brief message Phone locked is displayed each time you turn on the computer. The Enter 

phone lock code dialog opens. Enter your code into the dialog and click OK.

• Off - The GC75 is not locked.

• Automatic - If the Automatic setting is selected, the message Phone locked only appears when 

a different SIM card is inserted into the GC75. After the security code has been entered 

correctly, the GC75 can be used with the new SIM card.

Note:
The Phone Lock code has four to eight digits and is shown as asterisks upon entry in the 

dialog.

To Change the Phone Lock code:

1. Click . 

2. The Change the Phone Lock Code dialog opens. Make the required changes and click OK.

3. Click Apply when you have finished, to transfer the changes back to your GC75. This may take 

a few seconds.
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SIM lock

Some SIM cards are protected with a PIN (Personal Identity Number) at the time of purchase. If the 

SIM card lock is activated, you have to enter the PIN every time you turn on your PC and open GC75 

Manager. If you enter your PIN incorrectly three times in succession, the SIM card is blocked and 

you need a PUK code, from your network operator, to unblock the SIM card. 

• To activate the SIM card lock, select the On radio button.

Caution!
Only activate the SIM card lock if you know the PIN code.

• To cancel the SIM card lock, select the Off radio button.

Note:
You have to use your PIN code to turn the SIM card lock off.

To Change the PIN Code:

1. Click . 

2. Enter your old PIN code, followed by your new four digit PIN code. Confirm the new code by 

entering it again.

3. Click OK.

Note:
The SIM card lock only protects your subscription and not your GC75 from unauthorized use. 

If you change your SIM card, the GC75 will still work with a new SIM card.

4. Click Apply when you have finished to transfer the changes back to your GC75. This may take 

a few seconds.

Networks

Current Network

You can select which network you want to use by going to Networks and then choosing Current 

Network.

Searching for the available networks: 

• Click Retrieve, the current network appears in the box with all the other currently available 

networks.

The available networks will fall into one of the following three categories:

• The home network.

• Available networks, the name of the network is included in a list of preferred networks on your 

SIM card, therefore, you can use the network.

• Forbidden networks, you can’t use these networks except for emergency calls. If your home 

network and a forbidden network come to an agreement that allows you to use the forbidden 

network, you can select this network even though it is forbidden.
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Choosing another network:

1. Uncheck the Let my GC75 automatically choose a network for me.

2. Select the network that you want to use.

3. Click Apply to transfer the setting to your GC75.

The message Please wait appears briefly on the screen. If you are not allowed to use the network that 

you have chosen, Forbidden is displayed.

Note:
HSCSD is not available in every GSM network and requires a supplementary roaming 

agreement between mobile operators for visiting users to use HSCSD. Check with your home 

operator regarding the country or region in which you want to roam.

GPRS is commonly available in GSM networks, but fewer roaming agreements are in place. 

You may therefore need to explicitly select one of the available networks in order to use GPRS 

when abroad. Check with your home operator to find out which networks are GPRS roaming 

partners in the country or region in which you want to roam.

Preferred (network)

A list of preferred networks is stored on the SIM card. This is typically set up by your mobile 

operator as part of SIM manufacture. Preferred roaming partners are placed in the list so that you 

have the greatest range of available services whilst roaming. When the home network is not 

available, the GC75 will check the available networks against the preferred network list and select 

the one placed highest. Automatic network selection must be enabled.

If you want to add a new network:

1. Click Add, a new dialog with all the networks known to the GC75 appears on the screen.

2. Select the network that you want to add and click OK.

3. Click Apply to transfer the setting to your GC75 SIM card.

If you want to delete a network from the list:

1. Select the network that you want to delete.

2. Click Remove.

3. Click Apply to transfer the setting to your GC75 SIM card.

If you want to re-arrange the order of the networks listed:

1. Select the network that you want to move.

2. Click the Up or Down arrows to rearrange the order.

3. Click Apply to transfer the setting to your GC75 SIM card.

Note:
If the list of preferred networks is full, the Add button is disabled (grey).

Frequency Band

GSM operates in a number of different frequency bands. 900 and 1800 MHz are used in Europe, 

Asia, Australasia and Africa, whilst the 1900 MHz band is used in North and South America. By 

default your GC75 operates in 'tri-band' mode and automatically finds available networks in any of 

these frequency bands. It is not recommended to change this setting. See GSM Performance and 

technical characteristics on page 45 for a list of GSM frequency ranges.
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Divert Calls

Note:
The GC75 does not make or answer voice calls. The divert function enables you to send the 

voice call to an alternative number where they can be answered. For example, the mobile 

network voicemail service. However you can make and answer fax and data calls, providing 

you have appropriate software on your PC to handle them.

All

If you want to make certain that all your incoming calls are taken care of when you cannot answer 

them, you can use the Call divert service to divert them to another number that can handle the types 

of calls you expect to receive.

Note:
The Call divert service may not be available on all networks. 

Selecting a call divert setting:

1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes by identifying when you want to divert your incoming calls. You can select 

from four different diversion options:

– Always: this diverts all incoming calls to the phone number that you have entered in the text 

box

– When busy: for example, on CSD calls

– No reply

– Not reachable: for example, when your phone is turned off

3. If you know which number to divert your calls to, then type the number in the text box next to 

the divert option you have chosen.  
Or  

Click  to choose a phone number from your phonebook.

4. Click Apply, to transfer your new settings to your GC75. This may take a few seconds. 

Your call divert setting has now been stored in the network.

Line 1

You can use the Call divert service to divert your voice calls to another phone number.

Note:
The Call divert service may not be available on all networks. 

Selecting a call divert setting:

1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes and select in which situation you want to divert your incoming calls. You 

can select from four different diversion options:

– Always: this diverts all incoming calls to the phone number that you have entered in the text 

box

– When busy

– No reply

– Not reachable: for example, when your phone is turned off
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3. If you know which phone number to divert your calls to, type the number in the text box next to 

the divert option you have chosen.  
Or 

Click  to choose a phone number from your phonebook.

4. Click Apply to transfer them to your GC75. This may take a few seconds. 

Your Line 1 divert setting has now been stored in the network.

Fax

If you want to route your incoming fax calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the Call 

restricting function, this may influence Call divert.

Selecting a fax divert setting:

1. To obtain your current fax divert settings from the network, click Retrieve.

2. Select Always if you want to divert all the incoming calls to a specific phone number. 

3. If you know which phone number to divert your calls to, type the number in the text box next to 

Always.  
Or  

Click  to choose a phone number from your phonebook.

4. Click Apply to transfer your settings to your GC75. This may take a few seconds. 

Your fax divert setting has now been stored in the network.

Data

If you want to route your incoming data calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the Call 

restricting function, this may influence Call divert.

Selecting a data divert setting:

1. To obtain your current data divert settings from the network, click Retrieve.

2. Select Always if you want to divert all the incoming calls to a specific phone number. 

3. Select the Always check box and enter the destination number or click  to choose a phone 

number from your phonebook. Click OK.

4. Click Apply to transfer your settings to your GC75. This may take a few seconds. 

Your data divert setting has now been stored in the network.

Restrict Calls

Restricting a certain type of call means that this type of call cannot be made to or from your GC75. 

You can restrict different types of outgoing and incoming calls. 

The following call types can be restricted:



28 GC75 Manager Telephony Settings Screen

• all outgoing calls.

• all outgoing international calls.

• all outgoing international calls except to your own country.

• all incoming calls.

• all incoming calls when you are abroad (when roaming).

A password, issued with your subscription, is required to turn a call restrict on or off. Contact your 

network operator for further information.

Line 1 (restrict calls) Fax (restrict calls) and Data (restrict calls)

To Change the call restrict status for line 1, fax and data calls:

1. To get your current call restrict settings from the network, click Retrieve. 

2. Tick the boxes next to the call types that you want to restrict. 
Only select one outgoing and one incoming option.

3. When you have finished, click Apply.

4. Type your restriction password into the dialog and click OK.

Your call restrict settings have now been changed and stored in the network.
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GC75 Manager Phonebook Screen

The GC75 Manager Phonebook screen helps you to organize your GC75’s SIM Phonebook.

The Phonebook Screen

A SIM Phonebook can easily become disorganised; you can use the Phonebook screen to manage 

your SIM Phonebook entries.

You can add new numbers, edit existing numbers and export and import entries. 

1. Click  to display the Phonebook screen.

2. Icons appear in the left pane representing the SIM Phonebook  and Saved Phonebook . 

The first time the SIM Phonebook is opened in the Phonebook screen, an entire copy of the 

entries are copied to the Saved Phonebook. After this, any changes in the SIM Phonebook are 

automatically sent to the SIM card.

3. Click on the icon to display the Phonebook entries in the right pane.

Note:
Your GC75 must be inserted to display this information.
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Phonebook Functionality

To Add a Number:

1. Select Add new in the Phonebook menu or click  on the toolbar or key Ctrl and N.

2. The New Phonebook Entry dialog opens.

3. Enter the name and phone number.

4. Click OK to save the entry or Cancel to close the dialog.

Note:
Phonebook numbers are limited to 20 digits (including +) and names are limited to 18 

alphanumeric characters. 

New entries are added to the next available SIM index position. 

To Modify a number:

1. Select the number you want to modify.

2. Select Modify... in the Phonebook menu.

3. The Edit Phonebook Entry dialog opens.

4. The fields in the dialog display the current entry’s name and number. 

5. Edit the information.

6. Click Save to close the dialog and save your changes.  
If the modified entry is in the SIM Phonebook the changes are automatically sent to the SIM.

To Find Entries:

1. Select Find in the Phonebook menu or key Ctrl and F.

2. The Find dialog opens. Enter the text or number you want to search for in the Look for field. 

The entry can be complete or incomplete.

3. Click Find. The GC75 Manager searches both Phonebooks, when a match is found it is 

displayed in the right pane. Click Find Next to search again.

4. Click Close when you have finished searching.

To Copy an Entry:

1. Select an entry from the SIM Phonebook or the Saved Phonebook.

2. Select Copy To in the Phonebook menu. The Copy To option is followed by the name of the 

Phonebook you haven’t selected the entry from.

3. A duplicate entry is made in the specified Phonebook. The new entry is assigned the next 

available position in the destination Phonebook.



GC75 Manager Phonebook Screen 31

To Move an Entry:

1. Select an entry.

2. Select Move To in the Phonebook menu. The Move To option is followed by the name of the 

Phonebook you haven’t selected the entry from.

3. The entry is moved from its current Phonebook and placed in the selected one. The new entry is 

assigned the next available position in the destination Phonebook.

To Import an Entry or Phonebook:

1. Select Import from the Phonebook menu.

2. Select the Replace With Existing Phonebook or Merge with existing Phonebook radio 

button.

3. Click  and browse to find the file you want to import.

Note:
The file must be a text file in comma separated value (CSV) format. Any invalid lines or files 

will be ignored.

4. Click OK in the browse dialog. The path and file name are displayed in the Import File Name 

field.

5. Click Import to complete the import procedure.

To Export an Entry or Phonebook:

1. Highlight the entries or open the Phonebook you want to export.

2. Select Export from the Phonebook menu.

3. Select All to export the entire Phonebook or Selected Items to export the highlighted entries.

4. Type a name for the file into the Export File Name field.

5. Click  and identify the save location.
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Note:
The file will be saved as a text file in comma separated value (CSV) format.

6. Click OK in the browse dialog. The path and file name are displayed in the Export File Name 

field.

7. Click Export to complete the procedure.

Delete a number 

1. Select the number that you want to delete.

2. Select Delete, from the Phonebook menu. Click Yes to confirm the deletion.

Note:
If you want to delete all numbers, select Select All from the Edit menu before clicking Delete.

To Send a New SMS Message:

1. Select an entry from a Phonebook.

2. Select New Message To from the Phonebook menu.

3. A new SMS Message dialog is opened and pre-addressed with the selected entries details.
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GC75 Manager SMS Messages Screen

The GC75 Manager’s SMS Messages screen enables you to view, compose, edit, save, copy, delete, 

reply or forward SMS messages from your GC75 to other mobile devices. 

Note:
To use Message functionality SMS must be included in your subscription, contact your network 

operator for more details. 

The SMS Messages screen is split in to a left and right area.

The left area displays the folders; SIM SMS, Saved Messages, Sent Items and Unsent Items. 

The right area displays the contents of the selected folder. The top half of the right pane displays a 

list of received messages, sorted by date and the bottom half of the screen displays the content of a 

selected messages, this is referred to as the Information View.

The folders and their names are static, you can not change them.

Click to display the contents of the SIM Inbox. When GC75 Manager is opened 
any new SMS in the SIM Inbox are uploaded to the PC automatically. 
A status flag indicates whether a message is read or unread. 

If a new SMS arrives when the GC75 Manager is open  is displayed on the 
Status screen and the SMS audio sound is played, if enabled in the Setting dialog. 
See GC75 Manager Settings Options on page 14.

If you want to keep an SMS, use the copy or move menu options to place it in the 
Saved folder. Click on the folder icon to display the contents of the Saved folder. 
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Each time the SMS Messages screen receives a new SMS message from the SIM it checks the status 

of the SIM Inbox. If the SIM Inbox is full, a SIM Full icon is displayed in the left pane of the screen, 

see SIM Inbox is Full: on page 36.

Note:
For all the SMS Messages screen menu options to operate the GC75 must be registered 

successfully on a network. You must have a GSM signal to Send SMS, the button is disabled 

(grey) if you don’t have a signal.

SMS Manager Functionality

To Send an SMS:

1. Select Create New Message... from the Messages menu or click .

2. The New Message dialog opens.

3. Enter the recipient’s mobile phone number in the To: field or select a number from a phonebook 

by clicking Lookup.... 
To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the 

phonebook.

4. Type your message into the Message: field. 

5. Make sure your GC75 is inserted and your card is registered on a live network.

6. Click Send to send the SMS, Save to move the SMS to your Saved folder or Cancel to close the 

dialog without sending the SMS.

Note:
An SMS message can contain up to 160 characters (or 140 characters on some networks). 

When you enter text in the text box a counter is displayed in the upper right corner, If the 

number of characters exceeds 160, the SMS will be sent as several messages. The recipient 

will see the message as one long message no matter how many message are sent, provided 

their device supports this functionality. Your network operator will charge you with the number 

of messages sent.

To Edit a Message:

When you are working with a message, you can edit the text by cutting, copying and pasting.

Moving Text Within Existing Messages:

1. Select the text you want to move.

2. Select Cut from the Edit menu or Ctrl and X on the keyboard. 

3. Place the cursor where you want to insert the text and select Paste from the Edit menu or Ctrl 

and V on the keyboard.

A copy of each SMS that you have sent is stored in this folder. Click on the folder 
icon to display them. 

Any composed messages that have not been sent are displayed when you click on 
this icon. 
SMS stored in this folder can be edited or sent when the GC75 is connected. Any 
SMS that fail during transmission are also stored here, you can resend them at any 
time.
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Note:
If you want to copy text, select Copy (Ctrl and C) from the Edit menu instead of Cut (Ctrl and 

X). 

Reply to an SMS:

1. Select the folder where the message is located.

2. From the list, select the message you want to reply to. The contents of the message are displayed 

in the information view.

3. Select Reply in the Messages menu. A dialogue appears. The To: field is automatically filled in 

and the original message is displayed in the Message: field.

4. Type your reply and click Send. 

To Forward an SMS: 

1. Select the folder where the message is located.

2. From the list, select the message you want to forward. The contents of the message are 

displayed in the information view.

3. Click Forward, a dialogue opens. 

4. Enter the phone number in the To: field or click Lookup... to select a number from a 

phonebook. 
To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the 

phonebook.

5. Click Send.

Delete an SMS: 

1. Select the folder where the message is located.

2. From the list, select the message you want to delete. The contents of the message are displayed 

in the information view.

3. Select Delete from the Edit menu, or press the Delete button on your keyboard.

4. A confirmation message box opens, click Yes to delete the message.

Note:
To delete all messages, click Select All from the Edit menu before you select Delete.

Folder Management:

Sorting SMS:

1. Select the folder where the messages you want to sort are located.

2. Click the Date column heading to sort the SMS in ascending or descending date order.

Moving SMS:

1. Select the folder where the message you want to move is located.

2. From the list, select the message. The contents of the message are displayed in the information 

view.

3. Click Move to Saved Messages from the Messages menu.

4. The selected message is moved.
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Note:
To move all messages, click Select All from the Edit menu before you select Move to Saved 

Messages.

Copy an SMS:

1. Select the folder where the message you want to copy is located.

2. From the list, select the message. The contents of the message are displayed in the information 

view.

3. Click Copy to Saved Messages from the Messages menu.

4. The selected message is moved.

Note:
To copy all messages, click Select All from the Edit menu before you select Copy to Saved 

Messages.

SIM Inbox is Full:

When the GC75 Manager detects the SIM SMS storage is full, it displays  on the Status screen 

and in the SMS Messages screen. You must delete some SMS from the SIM Inbox to free storage 

space so that you can continue receiving new SMS from the network.



Troubleshooting 37

Troubleshooting

This chapter lists some problems that you might encounter while using your GC75. Some problems 

require you to contact your service provider, but most of the problems you can easily correct 

yourself.

GC75 Manager Icon Errors

Software Errors

Error Messages

General

 appears in 
the task bar

Indicates that the Radio is turned off. Right click the CMI, select 
Radio Settings from the sub menu, select On.

 appears in 
the task bar

Indicates that the GC75 cannot find a network, there is no network 
within range or the received signal is too weak. You have to move 
to get a stronger signal.

A signal is 
present but you 
can’t connect to 
the GPRS 
network

Indicates that a GSM network is present, but no GPRS service is 
available. This can be caused by; no GPRS service in the area, 
you are trying to roam on a network for which no GPRS roaming 
agreement exists or there is a temporary fault on the network. 
Contact your network operator for more details.

Grey menu 
options in the 
software 
applications

Grey text indicates a function that is temporarily unavailable, for 
example due to your subscription or due to a certain setting which 
has not been turned on.

Modem not 
responding.... 
Error

Check the radio is turned on.

Dial-Up fails Try to connect again.
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SIM Card Errors

Error Codes

Windows® 98

Wrong PIN/ 
Wrong PIN2

You have entered your PIN or PIN2 incorrectly. Enter the correct 
PIN or PIN2, and click OK. See SIM lock on page 24

Codes do not 
match

When you want to change a security code (for example your PIN) 
you have to confirm the new code by entering it again. This error 
occurs when the two codes, that you have entered do not match. 
See Phone lock on page 23.

PIN blocked/ 
PIN2 blocked

You have entered your PIN or PIN2 incorrectly three times in 
succession. To unblock, see SIM lock on page 24.

PUK blocked – 
contact operator

You have entered your personal unblocking key code (PUK) 
incorrectly 10 times in succession. Contact your network operator 
or service provider.

Error 619: The 
port is 
disconnected 
during dial-up

An ISDN mode (V110 or V120) has been selected when creating a 
connection, but is not supported by the network.
Select Analogue mode when creating the connection in the 
Connection Wizard.

Error 629: The 
port was 
disconnected 
by the remote 
machine during 
dial-up

Telephony settings are set to pulse dialling, change to tone dialling.

Check the dialling settings for the current location (In Control 

Panel  Phone and Modem Option  Dialling Rules  

Location  Edit) and change the Dial using setting to tone, or (if 
Pulse is a necessity), create a new location called GC75 
Anywhere and set the dialling to Tone. GC75 anywhere location
should then be used whenever you use the GC75.

Error 630: The 
port was 
disconnected 
due to hardware 
failure during 
dial-up

A Dial-up networking connection is already connected. Close the 
connected dial-up and try again.

Error 645: 
Internal 
authentication 
error during 
dial-up

Incorrect APN or CID selected for network.
Modify your Dial-up Connection, see Create a Dial-Up Connection 
on page 17 for more details. Make sure that the APN file contains 
the name of the access point your network operator is using. See 
the support section on www.SonyEricsson.com site for a full list 
of network operator APNs.

Error 650: The 
Remote Access 
server is not 
responding 
during dial-up

Incorrect User ID and/or password. Re enter correctly.
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Windows® 2000

Error 678: 
Computer you 
are dialling is 
not responding 
during dial-up

Either: Service is not supported by SIM (usually for CSD/HSCSD) 
or the computer is not answering.

1 Check SIM settings with your service provider if necessary,

2 Make sure that the server you are dialling is OK,

3 Make sure that Analogue mode has not been selected with 
57.6kbps data rate (V110 or V120 mode must be selected and 
supported by the network)

Error 720: No 
PPP control 
protocols 
configured 
during dial-up

The service is not supported by the SIM, usually appears when 
you are trying to connect to GPRS Internet. Contact service 
provider to enable GPRS Internet access on SIM card

Error 619: The 
port is 
disconnected 
during dial-up

An ISDN mode (V110 or V120) has been selected when creating a 
connection, but is not supported by the network.
Select Analogue mode when creating the connection in the 
Connection Wizard.

Error 678: 
Computer you 
are dialling is 
not responding 
during dial-up

Either: Service is not supported by SIM (usually for CSD/HSCSD) 
or the computer is not answering.

1 Check SIM settings with your service provider if necessary.

2 Make sure that the server you are dialling is OK.

3 Make sure that Analogue mode has not been selected with 
57.6 kbps data rate (V110 or V120 mode must be selected and 
supported by the network).

Error 691: 
Access denied, 
user name and 
password 
incorrect on the 
domain during 
dial-up

The domain name entry is incorrect.
Correct the domain name entry or delete if not required.

Error 718: PPP 
timeout during 
dial-up

This error indicates a PPP conversation started, but it was 
terminated because the remote server did not respond within an 
appropriate time. This can be caused by poor line quality or a 
problem with the server (ISP). This error can occur when your 
modem has connected to the ISP and has sent a username and 
password, but there is no response from the server. 
Wait a few minutes and try again
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All Windows® Operating Systems

Error 734: The 
PPP link control 
protocol was 
terminated 
during dial-up

The APN entry is incorrect, the signal is weak or the connection is 
lost whilst dialling.
See the support section on www.SonyEricsson.com site for a full 
list of network operator APNs.
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Additional Information

Sony Ericsson Support Web Site

At www.SonyEricsson.com/support you can find help and tips in a few clicks. The support site 

gives you access to:

• the latest software updates

• tips on how to use your GC75 efficiently

• function guides 

• additional help

Important Information

Please read this information before using your GC75.

Recommendations

• Always treat your product with care and keep it in a clean and dust-free place.

• Do not expose your product to liquid, moisture or humidity.

• Do not expose your product to extreme high or low temperatures.

• Do not expose your product to open flames or lit tobacco products.

• Do not drop, throw or try to bend your product. 

• Do not paint your product.

• Do not attempt to disassemble your product. Only Sony Ericsson authorized personnel should 

perform service.

• Do not remove the SIM

Antenna 

Only use an antenna that has been specifically designed by Sony Ericsson for your GC75. Use of 

unauthorized or modified antennas could damage your GC75.

Children

Do NOT allow children to play with your GC75. They could hurt themselves or others, or could 

accidentally damage the GC75. Your GC75 may contain small parts that could be detached and 

create a choking hazard.

Disposing of the Product 

Your GC75 should not be placed in municipal waste. Please check local regulations for disposal of 

electronic products.
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Electronic Devices

Most modern electronic equipment, for example equipment in hospitals and cars, is shielded from 

RF energy. However, certain electronic equipment is not, therefore: 

Do not use your GC75 near medical equipment without requesting permission. 

The GC75 may affect the operation of some implanted cardiac pacemakers and other medically 

implanted equipment. Pacemaker patients should be aware that the use of a GC75 very close to a 

pacemaker might cause the device to malfunction. Avoid placing the GC75 over the pacemaker. If a 

minimum distance of 15 cm (6'' inches) is kept between the GC75 and the pacemaker, the risk of 

interference is limited. If you have any reason to suspect that interference is taking place, 

immediately turn off your GC75. Contact your cardiologist for more information.

If you use any other personal medical device, consult the manufacturer of your device to determine 

if it is adequately shielded from external RF energy.

Turn your GC75 off in any facility where posted notices so require.

Aircraft

You MUST remove your GC75 before boarding any aircraft.

To prevent interference with communication systems and abide by the law, you must not use your 

GC75 while the plane is in the air.

Do not use it on the ground without permission from the crew.

Blasting Areas

Turn off your GC75 when in a blasting area or in areas posted turn off two-way radio to avoid 

interfering with blasting operations. Construction crews often use remote control RF devices to set 

off explosives.

Explosive Atmospheres

Turn off your GC75 when in any area with a potentially explosive atmosphere. It is rare, but your 

GC75 could generate sparks. Sparks in such areas could cause an explosion or fire resulting in bodily 

injury or even death. 

Areas with a potentially explosive atmosphere are often, but not always, clearly marked. They 

include fuelling areas, below deck on boats, fuel or chemical transfer or storage facilities, and areas 

where the air contains chemicals or particles, such as grain, dust, or metal powders.

Do not transport or store flammable gas, liquid, or explosives in the compartment of your vehicle, 

which contains your GC75 and accessories.

Inserting and removing the SIM card – precautions against electrostatic discharge (ESD)

Do not touch the SIM card connectors. As a precaution, always make sure that the GC75 is already 

in your hand before you insert or remove the SIM card.
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Technical Specifications

Exterior Description

Ambient Temperatures

Electrical Characteristics

Product name GC75

System E-GSM 900
GSM 1800
GSM 1900

Services supported CSD, HSCSD, GPRS, SMS
Speech services are not supported

SIM Card Small plug-in card, 3V or 5V type
SIM Lock supported

Type Number 6130201-BV

Size PC Card Type II, 16 bit
85.6 mm long x 54.0mm wide x 5.0 mm thick

Weight 38g including antenna, excluding SIM card

Battery Powered via the PC card slot i.e. uses laptop battery

Antenna 50 ohm interface; Antenna supplied

Operating 0 to 55 degrees C

Storage -20 to 65 degrees C

Supported Voltages 3.3V ± 10% 4.75-5.25V

Nominal Operating Voltage 3.6V 5.0V

Standby Current 4.2mA 4.2mA

Standby Power 
Consumption (no PDP 
context active)

13.8mW 21.0mW

Idle current (9/2 multiframe 
paging period) (PDP context 
active)

5.0mA/7.6mA 5.0mA/7.6mA

Idle power (9/2 multiframe) 16.5mW/25mW 25mW/38mW
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Operating System Support

Current Consumption

Maximum Current 800mA 800mA

Maximum Power 
Consumption

2W 3W

Supported Operating 
Systems

Microsoft Windowsá
 98 (SE)

Microsoft Windowsá
 Me

Microsoft Windowsá
 2000

Microsoft Windowsá XP

Minimum PC 
Specification

Processor size as recommended by Microsoft for the 

version of Windows® in use
30 MB free disk space

Current 
Consumption

Standby 
Switched on but not making a call and not attached to GPRS 
Current Consumption < 5 mA

Idle
Connected to the Internet using GPRS, in an ‘always connected’ 
state with no data flowing
Current Consumption < 8 mA

Transmitting (Max)
Maximum power output, GSM900
Current Consumption < 800 mA



Additional Information 45

GSM Performance and technical characteristics

GSM Features Supported

Dimension GSM 900/ 
E-GSM 900

GSM 1800 GSM 1900

Frequency 
Range

TX: 880 – 914 MHz
RX: 925 – 959 MHz

TX: 1710 – 1785 MHz
RX: 1805 – 1880 MHz

TX: 1850 – 1910 MHz
RX: 1930 – 1990 MHz

Channel 
Spacing

200 kHz 200 kHz 200 kHz

Number of 
Channels

175 Carriers * 8 
(TDMA)

374 Carriers * 8 
(TDMA)

299 Carriers * 8 
(TDMA)

Modulation GMSK GMSK GMSK

TX Phase 
Accuracy

5 degrees (RMS)
20 degrees (Peak)

5 degrees (RMS)
20 degrees (Peak)

5 degrees (RMS)
20 degrees (Peak)

Duplex 
spacing

45 MHz 95 MHz 80 MHz

Frequency 
Stability

0.1ppm 0.1ppm 0.1ppm

Transmitter 
RF Power 
Output

33 dBm Class 4
2 W peak

30 dBm Class 1
1 W peak

30 dBm Class 1
1 W peak

Transmitter 
Output 
Impedance

50W 50W 50W

Transmitter 
Spurious 
Emission

According to GSM 
spec

According to GSM 
spec

According to GSM 
spec

Receiver 
RF Level

-102 dBm -102 dBm -102 dBm

Receiver 
RX Bit 
Error Rate

<= 10-4 (Static Ch.)

<= 3% (EQ50 ch)
<= 10-4 (Static Ch.)

<= 3% (EQ50 ch)
<= 10-4 (Static Ch.)

<= 3% (EQ50 ch)

ME SIM Lock Yes

SIM Application 
Toolkit

Class 2 without call control.

USSD Support is provided via AT commands; No MMI is provided

Speech Coding Not applicable (GC75 does not support speech services)
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CSD technical data

HSCSD Maximum Data Rates (kbps)

The speeds given are maximums, Sony Ericsson cannot guarantee how fast your network will 

operate.

Standards AT commands industry standard ETSI 07.05, 07.07 and 
07.10, V.25ter command set supported

CSD Data Rates 9.6 kbps or 14.4 kbps depending on the GSM network

Compression MNP5 (Increases data rate up to 2x depending on data type)
V.42bis (Increases data rate up to 4x depending on data type)
GSM network support required for compression

Error Correction End to End MNP2 and LAPM (V.42)
RLP
Requires GSM Network support

GSM/ISDN According to V.110

9.6 kbps per 
timeslot

14.4 kbps per 
timeslot

4 + 1 RX 38.4 57.6 

TX 9.6 14.4

3 + 2 RX 28.8 43.2

TX 19.2 28.8
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GPRS technical data

Data Rates Multislot class 10 supported
See table below

Mode of Operation Class B (attaches to both GSM and GPRS at the same time; 
data connection is established using CS (CSD/HSCSD) or 
GPRS) The user may select CSD, HSCSD or GPRS modes 

via Dial-Up Networking configurations in Windowsá

GPRS Specification 
SMG 

SMG31bis

R Reference Point Physical layer: RS232 virtual COM port
Authentication mechanisms PAP and CHAP supported

IP Connectivity PDP type IP is supported

IPv4, terminated in Windows® DUN

SMS over GPRS Mobile Originated and Mobile Terminated

QoS Support for all 4 classes, details to be confirmed.

PDP Context Up to 10 PDP Context descriptions stored in GC75 memory
PDP Context description edited via supplied Wizard or AT-
command
Simultaneous PDP contexts not supported
Network initiated PDP context activation

SIM Support for GPRS aware as well as non-GPRS-aware SIMs

TCP/IP Header 
Compression

Compression V42bis
Support also required in GSM network

GPRS Encryption GEA1
GEA2
Support also required in GSM network

GPRS Frequency 
Hopping

Supported

GPRS IP allocation Dynamic
Static
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GPRS Maximum Data Rates

Speed achieved depends on the Coding Scheme supported by the GSM Network. The speeds given 

are maximums, Sony Ericsson cannot guarantee how fast your network will operate.

SMS Technical Data

Radio power output

Supported Languages

CS-1  
9.05 kbps

CS-2  
13.4 kbps

CS-3  
15.6 kbps

CS-4  
21.4 kbps

4 + 1 RX 36.2 53.6 62.4 85.6

TX 9.05 13.4 15.6 21.4

3 + 2 RX 27.15 40.2 46.8 64.2 

TX 18.1 26.8 31.2 42.8

Concatenated SMS Yes.

SMS interface Supplied end user application

GSM900 Class 4 2 W

GSM1800 Class 1 1 W

GSM1900 Class 1 1 W

Quick Start Guide
PC Software
User’s Guide (PDF)

English (EN)
Danish (DA)
Dutch (NL)
Finnish (FI)
French (FR)
German (DE)
Italian (IT)
Norwegian (NO)
Spanish (ES)
Swedish (SV)
Portuguese (PT)

AT Commands 
Manual

English
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License Agreement

License

Any use of the enclosed compact disc, diskette or any other media including upgrades thereof (“the 

Software”) shall be in accordance with the below stated license terms and conditions. By opening 

the sealed Software package and/or using the Software you agree to be bound by the terms and 

conditions stated below. These terms and conditions are binding and create a legal obligation (the 

“License Agreement”) between you (the “Licensee”) and Sony Ericsson Mobile Communications 

AB (the “Vendor”). 

The Software licensed hereunder may be delivered in an inseparable package also containing other 

software programs than this particular Software (e.g. bundled with other software). As a safeguard 

you should not in any way use the other software programs before reading the specific license terms 

and conditions of such other software.

License

You are hereby granted a non-transferable, non-exclusive right to use (“License”) the Software. 

You may only (a) use this Software on one single computer at a time; (b) physically transfer the 

Software from one computer to another if the Software is used only on one computer at a time and 

provided you remove any copies of the Software from the computer from which the Software is 

being transferred and/or on which it was originally used; (c) if necessary, make copies of the 

Software solely for purposes of backup. The copyright notice must always be reproduced and 

included on a label on any backup copy. 

You may not according to the EC Council Directive of May 14, 1991 on the legal protection of 

computer programs (91/250/EEG) (the “Software Directive”) distribute any copy of this Software or 

its documentation to others; nor modify, rent, lease or grant any rights to this Software whatsoever 

to another person or entity. In addition, you may not translate, reverse engineer, decompile, 

disassemble, reproduce or otherwise alter or modify the Software, its source code, documentation 

nor disclose any information designated as confidential or proprietary at the time of disclosure or, 

information which by its nature, is confidential or proprietary.

Term

Your License remains effective from the date of your cash receipt/proof of payment until terminated. 

You can terminate your License at any time by destroying the Software together with all copies of 

the Software in whichever form they may be. Your License will automatically terminate without 

prior notice if you fail to comply with any term or condition of this Agreement. In the event of 

termination of your License you must immediately destroy all copies of the Software in whichever 

form they may be.

Limited Warranty

Vendor warrants the media on which the Software is provided, to be free from defects in materials 

and workmanship under normal use for ninety (90) days after the date of your cash receipt/proof of 

payment. The Vendor's and its suppliers' entire liability and your exclusive remedy under this 

warranty will at Vendor's option be (and provided you return the Software to an authorized reseller/

supplier together with a copy of your cash receipt/proof of payment), to replace the disc(s)/ 

diskette(s) or refund the purchase price and terminate this Agreement including the License.
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Except for the above express limited warranties, Vendor and its suppliers do not provide nor do you 

receive any warranties or conditions whether express, implied, statutory or otherwise and Vendor 

and its suppliers specifically disclaim any implied warranties of satisfactory quality and/or fitness 

for a particular purpose. If your jurisdiction does not allow limitations on implied warranties to 

consumers, the above limitation may not apply to you. 

Vendor does not warrant that your use of the Software will be uninterrupted or error free. You 

assume full responsibility for the selection of this Software and your selected hardware and for the 

Software and hardware together achieving your intended results, as well as for any installation or use 

of or result obtained from the Software.

Intended use

The Software shall be used in accordance with the instructions and for its intended use and purpose 

only. The Software or part thereof may not be used in e.g. life support systems, nuclear facility 

applications, nor for the purposes of missile technology, chemical or biologized industry, flight 

navigation or communication of air, ground support equipment or other similar business or for any 

other purpose where any failure by the Software to perform may result in personal injury, death, 

damage to tangibles or the environment.

Limitation of liability

In no event shall Vendor or its suppliers be liable for any indirect or consequential losses or damages 

whatsoever irrespective of the cause for such losses or damages, including loss of data, loss of 

business profits or revenue, or any business interruption arising out of the use of or inability to use 

this Software. Vendor and its suppliers' total liability under this Agreement shall be limited to the 

amount actually paid by Licensee for the Software.

Disputes and Governing Law

The validity, construction and performance of this Agreement shall be governed by the laws of 

Sweden. All disputes, differences or questions between the parties with respect to any matter arising 

out of or relating to this Agreement shall be finally settled under the Rules of Conciliation and 

Arbitration of the International Chamber of Commerce, in Stockholm, by three (3) arbitrators 

appointed in accordance with the said Rules. The proceeding shall be conducted in the English 

language.
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Declaration of Conformity

We, Sony Ericsson Mobile Communications AB of

Nya Vattentornet

S-221 88 Lund, Sweden

declare under our sole responsibility that our product, 

Sony Ericsson type 6130201-BV, 

and in combination with our accessories, to which this declaration relates is in conformity with the 

appropriate standards 3GPP TS 51.010-1, EN 301489-7 and EN 60950, following the provisions of, 

Radio Equipment and Telecommunication Terminal Equipment directive 99/5/EC with 

requirements covering EMC directive 89/336/EEC, and Low voltage directive 73/23/EEC.

Basingstoke, January 2003

Place and date of issue

Anders Franzén

Corporate Vice President M2M Com

We fulfil the requirements of the R& TTE Directive (99/ 5/ EC)

 0682
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FCC Statement

Before a modem is available for sale to the public, it must be tested and certified to the FCC that it 

does not exceed the limit established by the government-adopted requirement for safe exposure. The 

tests are performed in positions and locations as required by the FCC for each model. Body worn 

measurements are made while the product is in use and worn on the body with an Sony Ericsson 

accessory. The design and composition of an accessory can affect the body worn SAR (Specific 

Absorption Rate) levels for the modem card. The distance used in the SAR Test Report for this 

device is 4mm. 

Sony Ericsson has not measured, and makes no representation about, the body worn SAR levels 

when the modem card is used with non-Sony Ericsson accessories.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) The device must accept any 

interference received, including interference that may cause undesired operation.

FCC-ID: PY76130201

Canada Certification: 4170B-6130201

FCc
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Appendix A - Connection Parameters

General Connection Parameters for CSD/HSCSD and GPRS

Required Useful information

Telephone 
number or 
Access Point 
Name (APN)

Number you need to dial to reach your service provider. Use the full 
number including country code and area code, e.g. +46 33 555 2525.
Or
The APN server resource to contact, for example,  
Interent.operator.net - to connect to the Internet via the mobile operator’s 
or your corporate Intranet via a VPN

Bearer 
capability:
CSD, HSCSD or 
GPRS?

You will need to know the bearer capability provided by your service 
provider, so you can select the appropriate option during set up.

CSD Network 
Speed

If you intend to create connections via CSD contact your network operator 
and check the supported speeds.

HSCSD Network 
Speed

If you intend to create connections via HSCSD contact your network 
operator and check the supported speeds.

Username The username your service provider gave you when the account was set 
up. Some dial-up accounts do not require a Username, in this case leave 
the field blank.

Password Password associated with the username, given to you by the service 
provider. Some dial-up accounts do not require a Password, in this case 
leave the field blank.

IP assignment: 
Server / Static

An ‘address’ that the service provider knows you by and uses to route 
information to and from your GC75. Your IP address will either be:
Server - assigned by the service provider when you connect. 
Static - assigned once by the service provider or the IT Manager.
If your IP address is Static you must enter it into Own IP address fields 
which is available when you select Details in the Connection APN dialog.

DNS 
assignment:
Server / Static

This tells the GC75 where to find the service provider’s DNS Service. DNS 
translates addresses such as www.sonyericsson.com to the numeric IP 
address so that the information can be accessed. 
Like IP assignment above, the DNS can be static or allocated by the 
service provider when you connect. If static is selected additional fields 
need to be completed containing the static information.

Own IP address Only required if the IP assignment is static.
Format example: 123.9.45.3.  
Do not enter any leading 0s when typing in IP address.

Primary DNS Only required if the DNS assignment is static.
Format example:123.9.45.2

Secondary DNS Only required if the DNS assignment is static.
Format example: 123.9.45.1

Access Point 
Name (APN)

If the APN is set to default you will have to enter the name of the access 
point your network operator is using.
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GPRS Specific Parameters

CSD/HSCSD Specific Parameters

Required Useful information

Enable Data 
Compression

Select to Enable Data Compression.
Data compression enables information to be transmitted beyond the actual 
connection speed. Data, particularly text and graphics, usually contain 
repeated sequences of identical information. Data compression works by 
replacing many characters of repeated information with a few characters 
and transmitting only one copy of repeated sequences of data.

Enable Header 
Compression

Select to Enable Header Compression.
without header overhead, fewer transceivers and radio network controllers 
are needed to handle traffic therefore speeding up data transfer.

Request Quality 
of Service

Select the bandwidth you want to use from the list supplied:
Precedence; Subscribed, Normal, High or Low
Delay; Subscribed, Class 1, Class 2, Class 3 or Best effort
Reliability; Subscribed, Class 1, Class 2, Class 3, Class 4 or Class 5
Peak Rate: Subscribed, Class 1, Class 2, Class 3, Class 4, Class 5, Class 
6, Class 7, Class 8 or Class 9
Mean Rate; Subscribed, Class 1, Class 2, Class 3, Class 4, Class 5, Class 
6, Class 7, Class 8, Class 9, Class 10, Class 11 or Class 12

Minimum 
Quality of 
Service

Select the minimum bandwidth you will use from the list supplied
Precedence; Subscribed, Normal, High or Low
Delay; Subscribed, Class 1, Class 2, Class 3 or Best effort
Reliability; Subscribed, Class 1, Class 2, Class 3, Class 4 or Class 5
Peak Rate: Subscribed, Class 1, Class 2, Class 3, Class 4, Class 5, Class 
6, Class 7, Class 8 or Class 9
Mean Rate; Subscribed, Class 1, Class 2, Class 3, Class 4, Class 5, Class 
6, Class 7, Class 8, Class 9, Class 10, Class 11 or Class 12

Required Useful information

Preferred 
Connection 
Speed (bits/s)

Select your preferred network connection speed from the drop down list 
provided:
9600, 14400, 19200, 28800 or 38400

Connection 
Mode

Select the method you want to use to connect to the network from the 
options provided:
analogue, ISDN V.110 or ISDN V.120

Compression Use to speed up data transfer. You can select to Enable Data 
Compression and Header Compression.

Transparent Choose to enter Transparent Mode HSCSD.
In this mode the transmission on the GSM circuit connection is treated as 
a packet data flow. The same packet will be sent many times if a error 
occur during transmission. GSM also supports transparent mode where bit 
error are not corrected. 
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Glossary

Bearer

Path over which data flows. Specifically in CSD and 

HSCSD, the type of telephony link from the GSM 

network to the server - V PSTN or ISDN.

bps

Bits per second - rate of data flow.

COM Port

Defines a serial/RS-232 port within the Windows® 

environment. May be physical (COM1 port on the rear of 

the PC) or virtual (COM5 port communicating with a PC 

card modem)

CS

Circuit Switched. Connection from A to B which has a 

fixed bandwidth and is maintained over a period of time, 

for example a voice telephone call.

CS-1 to CS-4

Coding Scheme. Determines the data rate per timeslot in 

GPRS.

CSD

Circuit Switched Data. CSD is a GSM service providing 

a CS data connection at a rate of 9.6 or 14.4 kbps.

DUN

Dial-Up Networking.

e-GSM

Extended GSM. New frequencies specified by the 

European Radio Communications Committee (ERC) for 

GSM use when additional spectrum is needed (Network-

dependent). It allows operators to transmit and receive 

just outside GSM’s core 900 frequency band. This 

extension gives increased network capability.

ETSI

European Telecommunications Standards Institute. 

www.etsi.org

GGSN

Gateway GPRS Support Node

GPRS

General Packet Radio Services.

GSM

Global System for Mobile Communications. GSM is the 

world’s most widely-used digital mobile phone system, 

now operating in over 160 countries around the world.

GSM 900

The GSM system family includes GSM 900, GSM 1800 

and GSM 1900. There are different phases of roll-out for 

the GSM system and GSM phones are either phase 1 or 

phase 2 compliant.

GSM 1800

Also known as DCS 1800 or PCN, this is a GSM digital 

network working on a frequency of 1800 MHz. It is used 

in Europe and Asia-Pacific.

GSM 1900

Also known as PCS. Refers to a GSM system running in 

the 1900MHz band. Used in the USA and Canada, for 

instance.

HSCSD

High Speed Circuit Switched Data.

HTML

HyperText Markup Language.

HTTP

HyperText Transfer Protocol.

ISDN

Integrated Services Digital Network. Can provide 

circuit-switched data connections in multiples of  
64 kbps.

ISP

Internet Service Provider.

kbps

Kilobits per second - rate of data flow.
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LAN

Local Area Network.

ME

Mobile Equipment.

MO

Mobile Origination. For example, an SMS message sent 

from a mobile terminal.

MMI

Man-Machine Interface.

MS

Mobile Station.

MT

Mobile Termination.

PC

Personal Computer.

PCS

Personal Communications Services, often used to 

describe GSM1900 networks.

PC Card

A card having physical and electrical characteristics 

specified by PCMCIA providing extra functionality 

when inserted into a laptop PC. Typical examples are 

modems and network cards. Type refers to the thickness 

of the card. The GC75 is type II.

PCMCIA

Personal Computer Memory Card International 

Association – defines specifications for PC Cards. 

www.pcmcia.org

PDP

Packet Data Protocol.

phonebook

A memory in the SIM card where phone numbers can be 

stored and accessed by name or position.

PSTN

Public Switched Telephone Network, for example 

ordinary analogue phone line for speech and/or computer 

modem.

RADIUS

Remote Access Dial-In Service. Facility at the ISP or 

corporation to manage remote data connections.

RX

Receive

SC

Service Centre (for SMS).

Service Provider

A company that provides services and subscriptions to 

GC75 users.

SIM card

Subscriber Identity Module card – a card that must be 

inserted in any GSM-based mobile terminal. It contains 

subscriber details, security information and memory for 

a personal directory of numbers. The card can be a small 

plug-in type or credit card-sized, but both types have the 

same functions. The GC75 uses the small plug-in card.

SMS

Short Message Service. Allows messages of up to 160 

characters to be sent and received via the network 

operator's message centre to a GC75.

TCP/IP

Transmission Control Protocol/Internet Protocol.

TCP/IPv4

TCP/IP Version 4. Most widely implemented form of 

TCP/IP today having a 4 byte address format such as 

212.161.127.136.

TE

Terminal Equipment. Generic term for GSM terminals 

such as phones and PC cards.

Terminal Adaptor

Generic term for the equipment terminating a digital 

comms line such as an ISDN2 line. The GC75 is a 

Terminal Adaptor since it interfaces to GSM digital data 

services.
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TLS

Transport Layer Security. Used by Web browsers, for 

example.

TX

Transmit

Type II

Refers to thickness of a PC Card as defined in the 

specification from PCMCIA.

URL

Uniform Resource Locator.

USSD

Unstructured Supplementary Services Data. Narrow-

band GSM data service. For example entering 

*79*1234# might return the stock price for stock 1234.

V.110

ETSI standard for data over an ISDN circuit.

V.120

ETSI standard for data over an ISDN circuit.

VPN

Virtual Private Network.

WAP

Wireless Application Protocol. A global standard 

specified in order to make Internet services available for 

mobile users.

www.ericsson.com/technology/WAP.shtml

WWW

World Wide Web.

XML

Extensible Markup Language



58 Index

Index

A

Assembling the Unit 10

C

Circuit Switched Data (CSD) 8

CSD technical data 46

Current Consumption 44

D

Deleting a SMS 35

Documentation 6

E

Exporting a Phonebook 31

G

GC75 Manager 6

GC75 Manager Icon 12

GC75 Manager Status Screen 20

General Packet Radio Service (GPRS) 9

GPRS Maximum Data Rates 48

GPRS technical data 47

GSM Features Supported 45

GSM Performance 45

H

Hardware Overview 5

SIM Card 5

High Speed Circuit Switched Data (HSCSD) 8

HSCSD Maximum Data Rates 46

I

Importing a Phonebook 31

Installation 10

Internet services 9

L

Locks 23

N

Network and Subscription 8

Circuit Switched Data (CSD) 8

General Packet Radio Service (GPRS) 9

High Speed Circuit Switched Data (HSCSD) 8

Short Message Service (SMS) 9

O

Operating System Support 44

P

Phone Numbers 22

R

Radio power output 48

Radio Settings 13

S

Sending a New SMS Message 32

Sending an SMS 34

Short Message Service (SMS) 9

SMS Technical Data 48

Software installation 10

Software Overview 6

GC75 Manager 6

Using the GC75 with your Applications 6

System Requirements

Network 8

Subscription 8

T

Telephony Settings 22

Locks 23

The Connection Monitor 21

W

Wireless Connection information

Status 13



Index 59

Wireless Connection Information Menu

Connect 14

Exit 14

Help 14

Open 13

Radio Status 13

Working with Phonebooks 30


